
CHÖÔNG XIV. 
PHAÂN TÍCH BAÛN ÑOÀ BAÈNG LEÄNH REDISTRICT

XIV.1. TOÅNG QUAÙT

Redistrict (goäp nhoùm) laø quaù trình xeáp caùc vaät theå ñoà hoaï treân baûn ñoà thaønh caùc
nhoùm khaùc nhau ñeå thöïc hieän tính toaùn treân döõ lieäu vaø cho ta keát quaû toång caùc giaù trò
caùc tröôøng döõ lieäu cuûa caùc nhoùm. Trong leänh naøy MapInfo taïo ra moät baûn ñoà chuû ñeà
kieåu Individual (xem Chöông XIII) vaø bieán soá (töùc tröôøng) ñöôïc söû duïng laø teân cuûa
nhoùm. Baûn ñoà seõ ñöôïc toâ maøu theo nhoùm ñoàng thôøi moät cöûa soå Districts Browser cuõng
môû ra hieån thò caùc nhoùm ñoù ôû daïng baûng soá lieäu.

Thöïc chaát quaù trình treân chæ laø moät phaàn cuûa leänh taïo vaø phaân chia nhoùm. Söùc
maïnh thöïc söï cuûa leänh naøy naèm trong cöûa soå Browser, laø nôi maø ta coù theå thaáy ngay
töùc khaéc söï caäp nhaät soá löôïng cuõng nhö caùc giaù trò toång khi nhaép chuoät leân moät vaät
theå treân baûn ñoà vaø gaùn noù sang moät nhoùm khaùc. Ñieàu naøy cho pheùp ta thöïc hieän pheùp
phaân tích tröïc quan theo kieåu “neáu nhö ... thì ...” ñeå coù ñöôïc söï saép xeáp döõ lieäu vöøa yù,
quaù trình naøy ñoâi khi ñöôïc goïi laø caân baèng taûi troïng (load balancing).

Khi ñaõ haøi loøng vôùi keát quaû phaân nhoùm, ta coù theå löu laïi keát quaû chia nhoùm ñoù. Sau
naøy khi coù nhu caàu phaùt sinh, ta coù theå thay ñoåi söï phaân nhoùm hoaëc thöû caùch phaân
nhoùm khaùc ñeå tìm ra giaûi phaùp toái öu cho nhu caàu cuûa mình.

Leänh Redistrict khoâng taïo ra caùc vaät theå ñoà hoaï môùi cuõng nhö khoâng thay ñoåi kieåu
toâ maøu cuûa caùc vaät theå treân baûn ñoà. Noù thöïc chaát chæ laø moät coâng cuï goäp nhoùm raát linh
ñoäng cho pheùp ta hieån thò caùc vaät theå treân baûn ñoà coù cuøng thuoäc tính (theo moät tröôøng
naøo ñoù) thaønh moät nhoùm. Leänh naøy khoâng taùc ñoäng leân caùc vaät theå ñoà hoïa treân baûn
ñoà nhöng ta coù theå löu laïi keát quaû phaân chia nhoùm vaøo döõ lieäu baèng leänh löu baûng.

Ta coù theå thöïc hieän leänh naøy treân baát kyø moät baûng coù baûn ñoà naøo chöùa caùc vaät theå
kieåu vuøng, ñöôøng hay ñieåm. Baûn ñoà goäp nhoùm taïo thaønh töø leänh naøy seõ phaûn aùnh caùc
kieåu toâ maøu (cho vuøng), kieåu ñöôøng hay kieåu ñieåm töông öùng. Leänh Redistrict giôùi haïn
soá nhoùm toái ña cho pheùp trong moät baûng laø 230.

Veà öùng duïng, ta coù theå söû duïng leänh naøy cho nhieàu muïc ñích khaùc nhau nhö taïo
vaø quaûn lyù caùc khu vöïc kinh doanh, phaân chia nhoùm caùc tröôøng hoïc, chia caáp quaûn lyù
caùc tuyeán ñöôøng giao thoâng, phaân vuøng quaûn lyù caùc taøi nguyeân thieân nhieân,... Leänh
naøy raát höõu ích khi caùc döõ lieäu ta caàn xöû lyù coù söï bieán ñoäng vaø phaûi thöû nhieàu phöông
aùn hay “kòch baûn” (scenario) khaùc nhau. Leänh naøy cuõng coù ích khi ta muoán taùi saép xeáp
laïi caùc nhoùm theo moät tröôøng naøo ñoù.
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XIV.1.1. Cöûa soå District Browser

Cöûa soå District Browser laø yeáu toá then choát cuûa quaù trình taïo vaø phaân nhoùm. Maëc
duø cöûa soå naøy troâng gioáng nhö caùc cöûa soå Browser khaùc trong MapInfo nhöng thöïc ra
noù laø moät cöûa soå raát linh hoaït cho pheùp ta thay ñoåi caùc nhoùm, tính toaùn laïi caùc giaù trò
toång ngay töùc khaéc. Ta coù theå thaáy ngay keát quaû söï thay ñoåi caùch phaân nhoùm cuûa ta.
Theâm nöõa, ta coù theå löu laïi nhöõng thay ñoåi hoaëc tieáp tuïc thöû caùc phöông aùn phaân nhoùm
khaùc.

Cöûa soå Districts Browser lieät keâ caùc nhoùm gioáng nhö trong baûng döõ lieäu, soá löôïng
cuûa töøng baûn ghi trong moät nhoùm, cuøng vôùi toång giaù trò döõ lieäu trong caùc tröôøng cuûa
chuùng do ta chæ ñònh. Ta chæ ñònh caùc tröôøng döõ lieäu naøy khi baét ñaàu thöïc hieän leänh goäp
nhoùm.

XIV.1.2. Nhoùm muïc tieâu - Target District

Nhoùm muïc tieâu laø moät baûn ghi ñöôïc choïn trong cöûa soå Districts Browser. Trong cöûa
soå naøy, luoân luoân coù moät baûn ghi ñöôïc choïn laø muïc tieâu. Trong quaù trình phaân chia
nhoùm, nhoùm muïc tieâu nhaän (caùc) vaät theå ñoà hoaï töø caùc nhoùm khaùc maø ta gaùn cho noù.
Khi môû cöûa soå Districts Browser, MapInfo töï ñoäng choïn nhoùm muïc tieâu laø haøng ñaàu
tieân, tuy nhieân ta coù theå thay ñoåi noù sang baát kyø nhoùm naøo baèng caùch nhaép chuoät vaøo
oâ vuoâng choïn beân traùi baûn ghi.

Coù 3 caùch ñeå choïn nhoùm muïc tieâu;

- Choïn moät baûn ghi (haøng) trong cöûa soå District Browser.
- Choïn moät vaät theå treân baûn ñoà, kích hoaït laïi cöûa soå Districts Browser, choïn leänh

Redistricter > Set Target District From Map (thieát laäp nhoùm muïc tieâu töø baûn ñoà).
Nhoùm naøo chöùa vaät theå ñoà hoaï ñöôïc choïn seõ trôû thaønh  nhoùm muïc tieâu.

- Choïn moät vaät theå treân baûn ñoà, kích hoaït laïi cöûa soå Districts Browser vaø choïn nuùt
leänh Set Target District treân thanh coâng cuï Main.

Nhoùm muïc tieâu ñöôïc nhaän dieän treân cöûa soå Browser vì noù laø nhoùm ñöôïc choïn.
Nhoùm muïc tieâu cuõng hieån thò ôû goùc döôùi beân traùi cuûa thanh Traïng thaùi.

Ñeå thay ñoåi nhoùm muïc tieâu, ta chæ caàn nhaép chuoät choïn moät nhoùm khaùc trong cöûa
soå Browser hoaëc choïn moät vaät theå treân baûn ñoà thuoäc moät nhoùm khaùc vaø choïn leänh Set
Target District From Map.

Luoân luoân coù moät (vaø chæ moät maø thoâi) nhoùm muïc tieâu vaøo moät thôøi ñieåm. Ta khoâng
theå khöû choïn nhoùm muïc tieâu baèng leänh Query > Unselect All.

Khi choïn (caùc) vaät theå treân cöûa soå baûn ñoà, MapInfo taïm thôøi gaùn chuùng vaøo nhoùm
muïc tieâu vaø tính laïi toång cho moãi nhoùm. Nhöõng thay ñoåi naøy ngay töùc khaéc ñöôïc phaûn
aùnh treân cöûa soå Browser. Soá löôïng caùc baûn ghi cuûa nhoùm muïc tieâu ñöôïc taêng leân cuõng
nhö toång giaù trò trong caùc coät döõ lieäu cuõng taêng theo ñeå phaûn aùnh vieäc theâm vaät theå
vaøo nhoùm muïc tieâu. Ñoàng thôøi vôùi noù laø toång giaù trò döõ lieäu cuõng nhö soá löôïng baûn ghi
cuûa nhoùm chöùa caùc vaät theå ñöôïc choïn seõ giaûm ñi, töông öùng vôùi söï loaïi boû (caùc) vaät
theå ra khoûi nhoùm ñoù.

XIV.1.3. Caùch thöïc hieän leänh Redistrict
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Noùi moät caùch toång quaùt, leänh Redistrict bao goàm nhöõng böôùc sau:

- Môû baûng caàn phaân tích ra.

- Töø menu chính choïn Window > New Redistrict Window.

- Choïn baûng caàn phaân tích vaø choïn caùc tröôøng caàn phaân tích trong hoäp thoaïi
Redistrict (hình XIV.1). Thöïc hieän xong MapInfo seõ hieån thò moät baûn ñoà ñöôïc toâ maøu
vaø môû cöûa soå Districts Browser ra.

- Choïn nhoùm muïc tieâu, neáu caàn.

- Choïn (caùc) vaät theå naøo treân cöûa soå baûn ñoà maø ta muoán ñöa vaøo nhoùm muïc tieâu.

- Quan saùt söï thay ñoåi caùc giaù trò döõ lieäu treân cöûa soå Districts Browser.
- Gaùn caùc vaät theå ñaõ choïn vaøo nhoùm muïc tieâu.

Trong tröôøng hôïp thöïc hieän phaân nhoùm treân moät tieâu chuaån chöa coù thì ta caàn taïo
ra moät tröôøng môùi ñeå chöùa caùc nhoùm. Xem caùch taïo tröôøng môùi trong Chöông XVII.

Chuù yù: Vì trong quaù trình thöïc hieän leänh naøy MapInfo duøng teân “Districts” khi chaïy
leänh neân ta khoâng ñöôïc duøng chöõ Districts ñeå ñaët teân cho moät baûng naøo ñoù.

XIV.1.4. Ví duï caùch thöïc hieän leänh Redistrict

Ta seõ söû duïng moät baûn ñoà ñeå minh hoaï cho leänh naøy. Baûn ñoà ñöôïc söû duïng ôû ñaây
laø baûn ñoà quy hoaïch quaän 4 ñeán naêm 2005 cuûa thaønh phoá Hoà Chí Minh. Baûn ñoà naøy
bao goàm 3 tröôøng; tröôøng thöù nhaát laø tröôøng thuoc_tinh (thuoäc tính), tröôøng naøy coù ñònh
daïng laø kieåu kyù töï, cho bieát khu vöïc ñöôïc quy hoaïch thuoäc loaïi gì; tröôøng thöù hai laø
tröôøng Code, quy ñònh maõ cuûa khu vöïc ñöôïc quy hoaïch, ñònh daïng kieåu Small Integer;
tröôøng thöù ba laø tröôøng dien_tich_ha (dieän tích), cho bieát dieän tích cuûa töøng khu vöïc
tính baèng hecta. Caùch thöïc hieän leänh naøy nhö sau:

Hình XIV.1. Hoäp thoaïi New Redistrict Window.
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- Môû baûng quy_hoach trong thö muïc Quan 4
- Choïn Window > New Redistrict Window; hoäp thoaïi New Redistrict Window môû ra

(hình XIV.1)

- Trong oâ Source Table, ta choïn baûng quy_hoach; trong District Field ta choïn tröôøng
thuoc_tinh. Trong oâ Available Fields ta coù nhieàu tröôøng vôùi caùc tính toaùn thoáng keâ

cho caùc tröôøng nhö Sum(Code), Pct(Code),... 
- Giaû söû ta caàn tính toaùn thoáng keâ trong tröôøng dieän tích neân ta seõ choïn

Sum(dien_tich_ha) roài nhaán nuùt Add >>, choïn Pct(dien_tich_ha) roài nhaán Add>>. Hai
tröôøng naøy seõ ñöôïc theâm vaøo trong oâ Fields to Browse ôû beân phaûi. Trong oâ naøy maëc
ñònh ta ñaõ coù thuoc_tinh, Count, Fill. 

Hình XIV.2. Baûn ñoà quaän 4 ñöôïc toâ maøu vaø cöûa soå Districts Browser môû ra.
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- Laøm xong choïn OK.

Ta thaáy raèng baûn ñoà quaän 4 ñaõ ñöôïc toâ maøu theo töøng khu vöïc quy hoaïch ñoàng
thôøi moät cöûa soå nöõa ñöôïc môû ra coù teân laø District Browser (hình XIV.2). Cöûa soå môùi
naøy bao goàm caùc coät:

- Coät thuoc_tinh: cho ta danh saùch caùc loaïi khu vöïc ñöôïc quy hoaïch.

- coät Sum(dien_tich_ha): coät naøy cho bieát dieän tích toång cuûa töøng kieåu khu vöïc.

- coät Pct(dien_tich_ha): coät naøy cho bieát tyû leä phaàn traêm cuûa töøng loaïi khu vöïc (Pct laø
vieát taét cuûa chöõ percentage - phaàn traêm).

- coät Fill: hieån thò maøu cuûa töøng loaïi khu vöïc. Ta coù theå nhaép chuoät leân töøng oâ maøu
ñeå ñoåi maøu neáu muoán.

- coät Count: cho bieát moãi loaïi khu vöïc ñöôïc quy hoaïch goàm bao nhieâu vaät theå, hay
bao nhieâu vuøng.

Ví duï nhö haøng ñaàu tieân laø “khu vöïc khoâng quy hoaïch” ta thaáy raèng loaïi naøy coù
toång dieän tích laø 13.8546 hecta (coät Sum(dien_tich_ha)), chieám tyû leä 5.48884% (coät
Pct(dien_tich_ha)) toång dieän tích ñaát quaän 4, ñöôïc toâ maøu ñoû (coät Fill) vaø toång coäng coù
26 vuøng (coät Count) ñöôïc xeáp vaøo loaïi quy hoaïch naøy.

XIV.1.5. Menu leänh Redistrict

Khi thöïc hieän xong leänh Redistrict vaø khi cöûa soå
Browser ñöôïc kích hoaït, treân menu chính hieän ra
moät menu nöõa laø Redistrict (hình XIV.3). Menu naøy
cho pheùp ta thöïc hieän moät soá chöùc naêng treân cöûa soå
Districts Browser.

Menu Redistrict bao goàm caùc leänh sau:

- Assign Selected Objects: Neáu ta choïn caùc vaät theå
treân baûn ñoà khi ñaõ chaïy xong leänh Redistrict thì
MapInfo seõ taïm thôøi gaùn nhöõng vaät theå ñöôïc
choïn ñoù vaøo nhoùm muïc tieâu hieän taïi. Nhoùm muïc
tieâu hieän taïi laø haøng ñang ñöôïc choïn trong cöûa soå Redistrict Browser. Khi choïn caùc
vaät theå treân cöûa soå baûn ñoà, ta thaáy caùc soá lieäu toång cuõng nhö tyû leä phaàn traêm thay
ñoåi töông öùng theo soá löôïng vaät theå ta choïn treân cöûa soå baûn ñoà. Khi thöïc hieän leänh
Redistrict > Assign Selected Objects, MapInfo seõ löu laïi teân (trong tröôøng hôïp ví duï
treân laø noäi dung trong tröôøng thuoc_tinh) cuûa nhoùm muïc tieâu vaøo moãi haøng cuûa
nhöõng vaät theå ñöôïc choïn luùc ñaàu. Nhö vaäy giaû söû neáu ta gaùn caùc vaät theå ñang ñöôïc
choïn vaøo moät nhoùm coù teân laø “khu vöïc khoâng quy hoaïch” thì MapInfo seõ löu “khu
vöïc khoâng quy hoaïch” vaøo tröôøng thuoc_tinh taïi töøng haøng cuûa moãi vaät theå ñöôïc
choïn, töùc laø thay ñoåi coät thuoc_tinh cuûa caùc vaät theå ñöôïc choïn thaønh “khu vöïc khoâng
quy hoaïch”. Vì leänh naøy laøm thay ñoåi döõ lieäu cuûa baûng, ta neâu löu laïi thaønh moät baûn
sao tröôùc khi thöïc taäp leänh naøy. Muoán löu laïi nhöõng thay ñoåi do leänh naøy taïo ra,
duøng leänh File > Save Table.

- Set Target District From Map: Nhö ñaõ trình baøy ôû phaàn treân, nhoùm muïc tieâu laø haøng
ñang ñöôïc choïn trong cöûa soå Districts Browser. Ta coù theå choïn nhoùm muïc tieâu baèng
caùch kích hoaït cöûa soå baûn ñoà vaø choïn moät vaät theå trong nhoùm muoán thieát laäp muïc

Hình XIV.3. Menu Redistrict.
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tieâu. Khi kích hoaït laïi cöûa soå Districts Browser, neáu ta choïn leänh Redistrict > Set tar-
get District from Map thì nhoùm chöùa vaät theå ñang ñöôïc choïn treân cöûa soå baûn ñoà seõ
ñöôïc choïn trong cöûa soå Districts Browser.

- Add District: Khi thöïc hieän leänh Redistrict > Add District, MapInfo seõ taïo ra moät nhoùm
môùi vaø theâm nhoùm ñoù vaøo haøng cuoái cuøng trong cöûa soå Districts Browser. MapInfo
seõ töï ñoäng gaùn moät teân maëc ñònh cho nhoùm môùi ñoù ví duï nhö “District 13”. Muoán
ñoåi teân cho nhoùm môùi ñoù, ta nhaép chuoät vaøo teân maëc ñònh ñoù vaø goõ teân môùi vaøo ñoù.

- Delete Target District: Khi thöïc hieän leänh naøy MapInfo seõ xoaù ñi nhoùm ñang laø nhoùm
muïc tieâu (töùc nhoùm ñang ñöôïc choïn trong cöûa soå Districts Browser). Taát caû nhöõng
vaät theå naøo ñang thuoäc nhoùm ñoù seõ bò gaùn laïi thaønh nhoùm “khoâng teân” (“unas-
signed” district). Ta khoâng theå xoaù unassigned district ñöôïc.

- Options: Khi choïn leänh naøy, hoäp thoaïi Redistricter Options môû ra (hình XIV.4). Hoäp
thoaïi naøy cho pheùp thieát laäp moät soá
tuyø choïn treân cöûa soå Districts
Browser. ÔÛ phaàn District Sort Order,
ta coù caùc tuyø choïn Most Recently
Used, xeáp thöù töï nhoùm theo hieån thò
môùi nhaát vöøa ñöôïc söû duïng;
Alphabetical, xeáp thöù nhoùm theo thöù
töï ABC vaø Unordered, khoâng xeáp
thöù töï nhoùm. Phía döôùi hoäp thoaïi
naøy laø 2 tuyø choïn, Show Grid Line
baät/taét ñöôøng phaân caùch caùc nhoùm
trong cöûa soå Districts Browser vaø
Save as Default cho pheùp ta löu thieát
laäp hieån thò hieän haønh cuûa cöûa soå
Districts Browser thaønh hieån thò maëc
ñònh.

Nhö vaäy ta thaáy raèng leänh goäp
nhoùm cho pheùp ta bieát ñöôïc khi xem xeùt moät tröôøng naøo ñoù trong moät baûng thì seõ coù
bao nhieâu vaät theå coù cuøng thuoäc tính trong tröôøng ñoù ñoàng thôøi cho ta toång caùc tröôøng
döõ lieäu cuøng vôùi tyû leä cuûa chuùng. Tuy nhieân, nhö ñaõ trình baøy, söùc maïnh thöïc söï cuûa
leänh naøy laïi naèm trong cöûa soå Districts Browser. Cöûa soå naøy cho pheùp ta thaáy ñöôïc
nhöõng caäp nhaät theo töøng nhoùm cuøng vôùi söï thay ñoåi cuûa döõ lieäu ngay töùc khaéc khi ta
nhaép chuoät choïn moät hay nhieàu vaät theå treân cöûa soå baûn ñoà, töùc laø gaùn noù sang nhoùm
ñang ñöôïc choïn.

XIV.2. VÍ DUÏ CHIA VUØNG QUAÛN LYÙ BAÈNG LEÄNH REDISTRICT

Trong ví duï naøy chuùng ta seõ nghieân cöùu caùch giaûi quyeát moät baøi toaùn phaân vuøng
quaûn lyù baèng leänh Redistrict. Baøi toaùn ôû ñaây laø chia vuøng quaûn lyù cho caùc traïm Kieåm
laâm taïi Vöôøn Quoác gia Caùt Tieân, khu vöïc Caùt Loäc.

Giaû söû raèng Vöôøn Quoác gia Caùt Tieân coù 5 traïm kieåm laâm taïi khu vöïc Caùt Loäc. OÂng
Haït tröôûng muoán thöïc hieän vieäc phaân chia khu vöïc Caùt Loäc ra thaønh 5 vuøng cho 5 traïm
Kieåm laâm naøy quaûn lyù. Nhö vaäy, trung bình moãi traïm kieåm laâm seõ quaûn lyù khoaûng 1/5
(töùc 20%) dieän tích khu vöïc. Tyû leä dieän tích naøy dó nhieân seõ khaùc nhau tuyø thuoäc vaøo

Hình XIV.4. Hoäp thoaïi Redistrict Options.
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möùc ñoä phöùc taïp cuûa ñòa baøn quaûn lyù cuûa töøng traïm.

Trong ví duï naøy chuùng ta seõ söû duïng caùc baûng sau: CL_tieu_khu.tab (caùc tieåu khu
trong khu vöïc Caùt Loäc, baûng kieåu vuøng), CL_tram_KL.tab (caùc traïm kieåm laâm trong khu
vöïc Caùt Loäc, kieåu ñieåm). Löu yù raèng toaï ñoä cuõng nhö caùc thoâng tin khaùc cuûa khu vöïc
Caùt Loäc ñaõ ñöôïc thay ñoåi khaùc vôùi thöïc teá.

Trong baûng CL_tieu_khu, ta coù taát caû 28 tieåu khu ñöôïc ñaùnh soá töø 1 ñeán 28 trong
tröôøng Ten_TK. Trong baûng CL_tram_KL ta coù 5 traïm kieåm laâm ñöôïc ñaùnh soá töø TRAÏM
I ñeán TRAÏM V trong tröôøng ten (hình XIV.5).

Giaû söû raèng khi soá hoaù baûng CL_tieu_khu, ngöôøi thöïc hieän chæ taïo tröôøng ten vaø ñaët

teân cho caùc tieåu khu. Ñeå thaáy ñöôïc söï phaân vuøng quaûn lyù lieân quan nhö theá naøo ñeán
dieän tích vaø chia dieän tích cho ñeàu ta caàn taïo theâm moät tröôøng nöõa cho baûng naøy, ñaët
teân tröôøng laø DT_ha (dieän tích tính baèng hecta), ñònh daïng kieåu tröôøng laø Float (Xem
caùch taïo tröôøng môùi trong Chöông XVII) vaø caäp nhaät dieän tích vaøo caùc tieåu khu. Trong
ví duï naøy, ta seõ minh hoaï vieäc söû duïng haøm soá loàng nhau. Ñeå caäp nhaät dieän tích vaøo
tröôøng DT_ha, ta laøm nhö sau:

- Môû baûng CL_tieu_khu ra.

- Töø menu chính choïn Update Column. Hoäp thoaïi Update Column môû ra.

- Trong oâ Table to Update choïn baûng CL_tieu_khu; trong oâ Column to Update choïn
tröôøng DT_ha.

- Nhaép chuoät vaøo nuùt Assist ñeå môû hoäp thoaïi Expression ra.

- Nhaép chuoät vaøo oâ Functions vaø choïn haøm Area (tính dieän tích). Haøm soá hieän ra trong

Hình XIV.5. Baûn ñoà caùc tieåu khu cuûa Caùt Loäc vaø caùc traïm Kieåm laâm.
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oâ Type an expression seõ laø Area (obj,”sq mi”). Ñôn vò tính dieän tích maëc ñònh
laø “sq mi” (square mile - daëm vuoâng), ta ñoåi thaønh hecta baèng caùch söûa chöõ “sq mi”
thaønh “hectare”. Bieåu thöùc seõ trôû thaønh Area(obj, “hectare”). Nhaán OK ñeå
quay laïi hoäp thoaïi Update Column, ta thaáy bieåu thöùc Area(obj, “hectare”)
ñöôïc naïp vaøo oâ Value.

- Ta bieát raèng khi caäp nhaät soá lieäu töø baûn ñoà baèng haøm soá, vôùi ñònh daïng tröôøng laø
Float, MapInfo seõ tính dieän tích/chieàu daøi vôùi soá leû raát daøi. Ñeå giaûi quyeát ñieàu naøy,
ta seõ söû duïng moät haøm soá khaùc laøm troøn giaù trò tính ñöôïc töø haøm tính dieän tích, ñoù
laø haøm Format$. Giaû söû ta muoán laøm troøn dieän tích tính ñöôïc thaønh hai soá leû ta seõ
theâm vaøo bieåu thöùc treân trong oâ Value nhö sau:

Format$(Area(obj,”hectare”),”#.##”)

Bieåu thöùc chöùa hai haøm soá loàng nhau naøy seõ ñöôïc thöïc hieän nhö sau: ñaàu tieân caùc
tieåu khu seõ ñöôïc caäp nhaät dieän tích baèng haøm Area(obj, “hectare”), sau ñoù
haøm Format$ seõ laøm troøn giaù trò tính ñöôïc , chuoãi #.## trong ngoaëc keùp cho bieát chæ laáy
hai soá leû sau daáu thaäp phaân (daáu chaám). Nhö vaäy ta seõ ñöôïc dieän tích cuûa caùc tieåu
khu ñöôïc laøm troøn coøn hai soá leû.

- Naïp xong bieåu thöùc vaøo oâ Value, ta nhaán OK. Taát caû caùc tieåu khu trong khu vöïc Caùt
Loäc seõ ñöôïc caäp nhaät dieän tích (hecta).

Ñeå thöïc hieän ñöôïc vieäc chia vuøng quaûn lyù, ta caàn chuaån bò moät soá vieäc nhö sau:

Phaân tích: tieåu khu naøo thuoäc traïm naøo quaûn lyù laø moät thuoäc tính môùi, vì theá tröôùc tieân
ta phaûi taïo theâm moät tröôøng môùi ñeå chöùa teân traïm kieåm laâm trong baûng CL_tieu_khu.
Caùch laøm:

- Choïn Table > Maintenance > Table Structure.

- Trong hoäp thoaïi View/Modify Table Structure, ta choïn baûng CL_tieu_khu, choïn OK.

Hình XIV.6. Tính dieän tích baèng haøm soá loàng nhau ñeå laøm troøn soá.
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- Nhaép chuoät choïn Add Field ñeå taïo theâm tröôøng môùi, ñoåi teân tröôøng môùi töø daïng
Fieldn thaønh Tram_QL (traïm quaûn lyù), ñònh daïng tröôøng laø Character, Width baèng
10 (trong thöïc teá, chieàu roäng tröôøng naøy phaûi ñuû daøi ñeå chöùa teân caùc traïm).

- Choïn OK. Baûng CL_tieu_khu ñoùng laïi.

- Môû baûng naøy ra laïi baèng leänh Window > New Map Window > choïn CL_tieu_khu.

- Môû baûng CL_tram_KL ra. Khi môû baûng, trong hoäp thoaïi Open Table, ôû döôùi cuøng nhôù
choïn tuyø choïn Preferred View laø Current Mapper ñeå môû baûng naøy chung vôùi baûng
CL_tieu_khu.

- Ñöa nhaõn cuûa caùc traïm Kieåm laâm vaø tieåu khu leân baûn ñoà ñeå phaân bieät. Caùch laøm:
+ Kích hoaït cöûa soå baûn ñoà. Töø menu chính choïn Map > Layer Control.
+ Trong hoäp thoaïi Layer Control, choïn baûng CL_tieu_khu roài choïn nuùt Label.
+ Trong oâ Label with, choïn tröôøng daùn nhaõn laø ten_TK. Ñònh daïng caùc yeáu toá khaùc

cuûa nhaõn neáu thaáy caàn thieát. Xong choïn OK.
+ Nhaép chuoät choïn baûng CL_tram_KL roài choïn nuùt Label. Thöïc hieän töông töï ñeå

daùn nhaõn caùc traïm kieåm laâm leân baûn ñoà theo tröôøng ten. Laøm xong choïn OK hai
laàn ñeå ñoùng hoäp thoaïi Layer Control laïi. Teân caùc traïm vaø teân caùc tieåu khu ñöôïc
ñöa leân baûn ñoà (xem laïi hình XIV.5).

Ta baét ñaàu thöïc hieän vieäc phaân chia vuøng nhö sau:

1  - Kích hoaït laïi cöûa soå baûn ñoà, neáu caàn.

2  - Töø menu chính choïn Window > New Redistrict Window. Hoäp thoaïi New
Redistrict Window môû ra.

3  - Trong oâ Source Table ta choïn baûng CL_tieu_khu; trong oâ District Field choïn
Tram_QL; nhaép chuoät vaøo Sum(DT_ha) (tính toång dieän tích) vaø nhaán nuùt Add>>
ñeå theâm noù vaøo oâ Fields to Browse, töông töï theâm Pct(DT_ha) (tính phaàn traêm
dieän tích) vaøo oâ Fields to Browse.

Hình XIV.7. Cöûa soå New Redistrict Browser cho baûng CL_tieu_khu.
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4  - Laøm xong choïn OK. Ta thaáy cöûa soå Districts Browser môû ra (hình XIV.8). Baûng
naøy chæ coù moät haøng duy nhaát. Coät Tram_QL coù 5 daáu sao. Ñoù chính laø unas-
signed district, nhoùm “khoâng teân” hay nhoùm chöa ñöôïc gaùn giaù trò. Coät Count coù
giaù trò laø 28 töông öùng vôùi 28 tieåu khu. Giaù trò trong coät Sum(DT_ha) laø toång dieän
tích cuûa caùc tieåu khu vaø Pct(DT_ha) laø tyû leä phaàn traêm. Luùc naøy chöa coù tieåu
khu naøo ñöôïc gaùn cho traïm Kieåm laâm naøo quaûn lyù caû neân taát caû caùc tieåu khu
ñeàu thuoäc nhoùm “khoâng teân” vaø chieám 100%.

Ta tieán haønh phaân chia caùc tieåu khu cho caùc traïm kieåm laâm, giaû söû baét ñaàu töø Traïm
I. Nhaép chuoät vaøo cöûa soå Districts Browser ñeå kích hoaït laïi noù, neáu caàn.

5  - Töø menu chính choïn Redistrict > Add District. Moät haøng nöõa ñöôïc theâm vaøo cöûa
soå Districts Browser vaø ñöôïc ñaët teân laø Distric2 (töùc District 2 - nhoùm 2, nhoùm 1
laø nhoùm khoâng teân).

6  - Nhaép chuoät vaøo nuùt chænh kieåu chöõ treân thanh coâng cuï Main vaø chænh kieåu
chöõ trong cöûa soå Districts Browser veà tieáng Vieät, VNI-Helve chaúng haïn. Nhaép
chuoät vaøo oâ Distric2 vaø söûa teân noù laïi thaønh “Traïm I” (hình XIV.9).

7  - Trong coät Fill, Traïm I ñöôïc toâ maøu, ta coù theå nhaép chuoät leân oâ maøu ñoù ñeå vaøo
hoäp thoaïi Fill Style vaø ñoåi maøu, neáu muoán.

8  - Nhaép chuoät vaøo oâ vuoâng beân traùi cuûa Traïm I, oâ vuoâng naøy ñöôïc toâ ñen. Nhö
vaäy Traïm I ñöôïc bieán thaønh nhoùm muïc tieâu.

Ta baét ñaàu thöïc hieän phaân chia tieåu khu cho Traïm I. Caùch laøm nhö sau:

9  - Nhaép chuoät choïn laïi nuùt coâng cuï choïn treân thanh coâng cuï Main.

10 - Di chuyeån chuoät trôû laïi cöûa soå baûn ñoà. Nhaép chuoät leân moät tieåu khu, ví duï tieåu
khu 1 chaúng haïn, laäp töùc ta thaáy trong cöûa soå Districts Browser, ôû haøng cuûa

Hình XIV.8. Cöûa soå Districts Browser khi tröôøng
Tram_QL chöa ñöôïc naïp döõ lieäu.

Hình XIV.9. Taïo moät nhoùm môùi baèng leänh Add District.
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Traïm I, coät Count chuyeån thaønh soá 1, coät Sum(DT_ha) hieän leân dieän tích cuûa
tieåu khu môùi ñöôïc choïn, coät Pct(DT_ha) hieän leân tyû leä phaàn traêm cuûa tieåu khu
ñoù so vôùi toång dieän tích.

11 - Giöõ phím <Shift> vaø nhaép chuoät leân moät tieåu khu nöõa, ta thaáy tieåu khu naøy
cuõng ñöôïc theâm vaøo haøng Traïm I, dieän tích vaø tyû leä phaàn traêm töông öùng taêng
leân. Neáu ñeå yù ta thaáy treân coät unassigned district ôû treân, dieän tích toång vaø tyû leä
phaàn traêm giaûm ñi töông öùng.

12 - Tieáp tuïc giöõ phím <Shift> vaø nhaép chuoät leân caùc tieåu khu khaùc döï kieán giao
cho Traïm I quaûn lyù cho ñeán khi naøo öng yù thì thoâi. Giaû söû ta ñaõ choïn caùc tieåu
khu 1, 3, 8, 9, 14 vaø 15 ñeå giao cho traïm I quaûn lyù. Keát quaû laø ta thaáy treân cöûa
soå Districts Browser hieän ra thoáng keâ soá lieäu cuûa Traïm 1 nhö sau: toång soá tieåu
khu quaûn lyù (coät Count) laø 6, toång dieän tích (Coät Sum(DT_ha)) laø 7,321.03 ha vaø
chieám 22.2016% dieän tích toaøn khu vöïc (coät Pct(DT_ha)). Vaø khu vöïc do Traïm I
quaûn lyù seõ ñöôïc ñaùnh daáu laø soïc cheùo.

13 - Neáu öng yù vôùi keát quaû ñoù, ta kích hoaït laïi cöûa soå Districts Browser baèng caùch
nhaép chuoät leân thanh tieâu ñeà cuûa cöûa soå vaø töø menu chính choïn Redistrict >

Hình XIV.10. Khi Traïm I ñöôïc trôû thaønh nhoùm muïc tieâu, choïn tieåu khu
naøo treân baûn ñoà seõ theâm tieåu khu ñoù vaøo baûn ghi cuûa Traïm I.

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


Assign Selected Objects (gaùn caùc vaät theå ñöôïc choïn treân baûn ñoà vaøo nhoùm muïc
tieâu). Laäp töùc 6 tieåu khu ñöôïc choïn seõ ñöôïc toâ maøu (hình XIV.10) vaø trong
tröôøng Tram_QL cuûa baûng CL_tieu_khu, caùc tieåu khu ñoù seõ coù teân Traïm I. 

14 - Tieáp tuïc choïn tieåu khu cho Traïm II. Tröôùc tieân ta phaûi taïo ra Traïm II. Kích hoaït
laïi cöûa soå Districts Browser. Töø menu chính choïn Redistrict > Add District. Moät
haøng nöõa ñöôïc taïo ra trong cöûa soå Districts Browser. Söûa teân maëc ñònh trong
haøng môùi ñoù thaønh TRAÏM II. Nhaép chuoät vaøo oâ maøu cuûa haøng ñoù ñeå ñoåi maøu,
neáu muoán.

Ta laïi baét ñaàu tieán haønh choïn caùc tieåu khu cho Traïm II.
15 - Treân cöûa soå Districts Browser, nhaép chuoät vaøo oâ vuoâng beân traùi ñeå choïn Traïm

II. OÂ vuoâng ñöôïc toâ ñen vaø Traïm II trôû thaønh nhoùm muïc tieâu.

16 - Choïn coâng cuï choïn treân thanh coâng cuï Main vaø di chuyeån chuoät trôû laïi cöûa soå
baûn ñoà.

17 - Giöõ phím <Shift> vaø laïi nhaép chuoät choïn caùc tieåu khu döï kieán giao cho Traïm II
quaûn lyù. Töông töï nhö Traïm I, ta thaáy toång dieän tích vaø tyû leä phaàn traêm cuûa caùc
tieåu khu ñöôïc choïn cho Traïm II taêng leân töø töø, ñoàng thôøi dieän tích toång vaø tyû leä
phaàn traêm ôû nhoùm khoâng teân giaûm töông öùng.

18 - Khi naøo öng yù vôùi soá tieåu khu giao cho Traïm II, ta kích hoaït laïi cöûa soå Districts
Browser vaø töø menu chính choïn Redistrict > Assign Selected Objects. Caùc tieåu
khu ñöôïc choïn seõ ñöôïc gaùn teân Traïm II vaøo tröôøng Tram_QL.

Thöïc hieän töông töï nhö vaäy töø böôùc 14 ñeán
böôùc 18 ôû treân ñoái vôùi 3 traïm coøn laïi cho ñeán khi
naøo hoaøn taát choïn caùc tieåu khu cho töøng traïm.
Ñeå yù söï thay ñoåi tyû leä phaàn traêm  dieän tích trong
coät Pct(DT_ha) ñeå ñaûm baûo phaân chia dieän tích
quaûn lyù cho caùc traïm moät caùch hôïp lyù. Giaû söû
keát quaû cuoái cuøng coù theå seõ troâng gioáng nhö
treân hình XIV.11. Neáu caûm thaáy öng yù ta choïn
File > Save Table. Choïn baûng CL_tieu_khu vaø
choïn Save thì keát quaû chia tieåu khu naøy seõ ñöôïc
löu laïi trong baûng CL_tieu_khu. Ñeå thaáy ñöôïc
keát quaû, töø menu chính choïn Window > New
Browser Window > choïn baûng CL_tieu_khu. Cöûa
soå döõ lieäu môû ra vaø trong töøng tieåu khu ta seõ
thaáy teân caùc traïm quaûn lyù töông öùng trong coät
Tram_QL. Ta coù theå taét cöûa soå Districts Browser
vaø keát thuùc leänh phaân nhoùm.

Giaû söû vì moät lyù do naøo ñoù, sau naøy ta muoán thay ñoåi laïi söï saép xeáp caùc tieåu khu
cho caùc traïm. Ta coù theå söû duïng leänh Redistrict naøy trôû laïi nhö sau:

- Thöïc hieän töông töï töø böôùc 1 ñeán böôùc 4 ôû treân.

- Cöûa soå Districts Browser môû ra nhöng luùc naøy noù ñaõ ñöôïc toâ maøu thaønh 5 vuøng,
ñoàng thôøi cöûa soå Districts Browser seõ coù 5 haøng töông öùng vôùi khu vöïc quaûn lyù cuûa
5 traïm Kieåm laâm (luoân luoân seõ coù theâm moät haøng nöõa coù 5 daáu hoa thò, ñoù laø nhoùm
khoâng teân, haøng naøy luoân hieän dieän vaø khoâng theå xoaù ñöôïc).
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Giaû söû ta muoán chuyeån tieåu khu 9 töø traùch nhieäm quaûn lyù cuûa Traïm I sang traùch
nhieäm quaûn lyù cuûa Traïm III. Caùch laøm nhö sau:

- Trong cöûa soå Districts Browser, nhaép chuoät vaøo oâ vuoâng beân traùi choïn Traïm III, noù
trôû thaønh nhoùm muïc tieâu.

- Choïn nuùt choïn treân thanh coâng cuï Main. Di chuyeån chuoät trôû laïi cöûa soå baûn ñoà.

- Nhaép chuoät leân tieåu khu 9, laäp töùc ta thaáy tieåu khu naøy ñöôïc coäng vaøo khu vöïc quaûn
lyù cuûa Traïm III, coät Count taêng theâm 1, dieän tích vaø tyû leä phaàn traêm taêng leân töông
öùng, ñoàng thôøi laø coät Count ôû Traïm I giaûm ñi 1, dieän tích vaø tyû leä phaàn traêm giaûm ñi
töông öùng.

- Töông töï nhö vaäy, neáu ta muoán ñöa moät tieåu khu naøo khaùc theâm vaøo khu vöïc quaûn
lyù cuûa Traïm III, giöõ phím <Shift> vaø nhaép chuoät choïn tieåu khu ñoù. Traïm naøo hieän

Hình XIV.11. Keát quaû chia tieåu khu cho caùc traïm Kieåm laâm.
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ñang quaûn lyù tieåu khu ñöôïc choïn seõ giaûm dieän tích vaø tyû leä ñi töông öùng vaø dieän
tích vaø soá tieåu khu traïm III quaûn lyù seõ taêng leân.

- Neáu öng yù vôùi keát quaû chia laïi ñoù, ta kích hoaït cöûa soå Districts Browser vaø choïn
Redistrict > Assign Selected Objects. Laäp töùc caùc tieåu khu ñöôïc choïn seõ ñöôïc ñoåi
maøu thaønh khu vöïc quaûn lyù cuûa Traïm III.

- Töông töï nhö vaäy ta coù theå thay ñoåi khu vöïc quaûn lyù cuûa caùc traïm neáu muoán, vaø khi
öng yù ta choïn Redistrict > Assign Selected Objects.

- Ñeå löu laïi keát quaû naøy ta vaøo menu File vaø choïn Save Table, luùc ñoù trong baûng
CL_tieu_khu, döõ lieäu caùc traïm seõ ñöôïc thay ñoåi theo yù muoán cuûa ta.

Dó nhieân trong ví duï naøy ta chæ thöïc hieän vieäc phaân chia nhoùm sao cho töông ñoái
caân baèng veà dieän tích quaûn lyù. Trong thöïc teá vaán ñeà khoâng ñôn giaûn nhö vaäy vì coøn
nhieàu yeáu toá khaùc taùc ñoäng leân vieäc phaân chia khu vöïc quaûn lyù, ví duï nhö heä thoáng
ñöôøng tuaàn tra, tính phöùc taïp cuûa khu vöïc quaûn lyù, soá löôïng ngöôøi cuûa caùc traïm kieåm
laâm,... Trong quaù trình thöïc hieän leänh naøy ta coù theå môû theâm caùc lôùp thoâng tin khaùc ñeå
thöïc hieän vieäc choïn nhoùm cho phuø hôïp. Ta seõ quay laïi ví duï naøy moät caùch chi tieát hôn
trong Chöông XX.
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